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Introduction 
This guide is designed to help you understand the steps to upgrade Capital Gold Payroll, complete 
the year-end and start the 2018-19 tax year. You must follow these steps for each company in 
Capital Gold Payroll. 

The guide is designed to be read on-screen or printed. Make sure that you follow the instructions 
carefully. 

Other companion guides are available with this guide: 

Guide Description 

Release Guide This guide is designed to help you understand the legislation and 
software changes to this year’s payroll upgrade for the 2017-18 year end 
and the new 2018-19 tax year. Changes for pensions and auto enrolment 
are also included. 

Auto Enrolment This guide will demonstrate how Capital Gold Payroll can help you carry 
out your Auto Enrolment responsibilities. 

Auto Enrolment 
Configuration Tool 

A guide that explains the Auto Enrolment Configuration Tool, which is 
accessed from the Pensions menu. 

F1 Help The help includes sections that describe the software changes in this 
release and explains each of the screens in the product. This can be 
accessed via the Help Menu - Capital Gold Payroll Help or by using the 
F1 button. 

Audience 
This guide is provided for both Pegasus partners and Capital Gold Payroll customers. The guide 
assumes you have relevant knowledge of Capital Gold Payroll and understand existing HMRC 
requirements of employers.  

Installation and Upgrade instructions 
Full instructions for installing and upgrading Capital Gold Payroll are included in the Installation 
Guide available from the installation screen. You may need to refer to that guide when installing the 
product if you are unfamiliar with the installations. The system requirements to run Capital Gold 
Payroll are also included in the Installation Guide. 

Download instructions 
Capital Gold Payroll (4.05) is available for download. Download instructions are included as a link in 
the release notification email. 
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Considerations before you start 
Before starting the steps, you may want to consider the notes in this section.  

Running weeks 53/54/56 
 Weekly payroll with a pay date of 5th April should be week 53 

 2-weekly payroll with a pay date of 5th April should be week 54 

 4-weekly payroll with a pay date of 5th April should be week 56. 

For week 53, 54 and 56 payrolls Capital Gold Payroll will automatically apply the week 1 tax basis 
as outlined by HMRC. You do not have to make any changes. 

Issuing P45s 
Before running the Year-end Restart issue P45s for employees who you do not intend to pay in the 
2018-19 tax year. 

Directors NI calculations 
If you started using Capital Gold Payroll part way through the current tax year and imported your 
data from another payroll system, check year-to-date NI calculations for Directors. 

Follow HMRC leaflet CA44 National Insurance for company directors or use the Director’s National 
Insurance contributions calculator listed at www.gov.uk/government/collections/how-to-manually-
check-your-payroll-calculations. 

Running payrolls in the new tax year before printing P60s 
If you need to start running payrolls in the new tax year, before printing P60s, do the Year-end 
Restart and then run payrolls in the new tax year as normal. When you do the Year-end Restart, 
the company is copied automatically. 

YOUR FINAL FPS MUST BE SENT BEFORE 19 APRIL 2018. AFTER THIS ANY CHANGES 
FROM THE PREVIOUS TAX YEAR MUST BE SUBMITTED VIA THE EARLIER YEAR 
UPDATE OR BY USING HMRC BASIC TOOLS. 

When you are ready to print your P60s 
From the File menu, select Use Last Year’s Company Data. This restores the data to what it was 
before the Year-end Restart. 

A confirmation message is displayed. When the previous year’s data is in use, the tax year is 
displayed in the title bar after the company name. 

Print P60s as described in the Completing the Tax Year-End section of this guide on page 7. 

Once finished, return to your current data by again selecting Use Last Year’s Company Data from 
the File menu. 

DO NOT PERFORM A SECOND YEAR-END RESTART WHEN YOU ARE USING LAST 
YEAR’S DATA. 

The Last Year copy is not a substitute for your end of year back up. When Capital Gold Payroll 
makes the automatic copy during the Year-end Restart, data already stored in the ‘LastYear’ folder 
for the current company is overwritten. This happens every time a Year-end Restart is done for that 
company so only the previous tax year’s copy is ever available. 

Ordering P60s 
Order from: 

 shop.kalamazoodirect.co.uk 

 www.hmrc.gov.uk/gds/payerti/forms-updates/forms-publications/onlineorder.htm 
(‘P60 (Single sheet/Shortened)’ option) 

 

  

https://www.gov.uk/government/collections/how-to-manually-check-your-payroll-calculations
https://www.gov.uk/government/collections/how-to-manually-check-your-payroll-calculations
https://shop.kalamazoodirect.co.uk/
https://shop.kalamazoodirect.co.uk/
http://www.hmrc.gov.uk/gds/payerti/forms-updates/forms-publications/onlineorder.htm
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STEP 1: Upgrading Capital Gold Payroll 
THIS CHECKLIST DETAILS THE SUGGESTED STEPS FOR THIS PROCESS. PLEASE 
AMEND AS NECESSARY. 

This section includes the steps required to upgrade to Capital Gold Payroll (4.05) before completing 
the year end tasks.  

THE SOFTWARE CAN BE INSTALLED IN ANY PAY PERIOD BEFORE THE END OF THE 2017-
18 TAX YEAR. HOWEVER, IT MUST BE INSTALLED BEFORE PROCESSING THE YEAR END.  

Before Upgrading the Software 

1. Capital Gold payroll (4.04 or later) should already be installed before upgrading. Use 
the Help - About Capital Gold Payroll menu in Capital Gold Payroll to check the 
version number. 

 

2. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 
Back-up Company Data command.  

 

It is advisable to back up your data to a 
new folder so that it does not overwrite an 
existing backup. In the Backup to box, first 
remove the text that is displayed. Then 
enter the drive letter and a new folder 
name for the current pay period, for 
example ‘C:\March2018_A’. 

 

 

3. Carry out a full payroll cycle using the Payroll - Do/Redo Payroll command for 
each company, and printing the necessary reports.  

4. Close Capital Gold Payroll. 

 

Upgrading the Software 

5. Install the software before processing starts in the new pay period. 

 

Separate instructions for 
downloading the installation files are 
included with your release letter. 

This screen will appear automatically 
after the software has downloaded. 

 

 

 

6. Familiarise yourself with the legislation that affects this release by clicking the View 
Release Guide link. Click View Readme to see a summary of the software 
changes. 

 

7. Click Install Capital Gold Payroll to upgrade the product. Follow the instructions on 
the screen to complete the upgrade and when asked use the ‘Typical’ set up type.  
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After Upgrading the Software 

8. Log in to Capital Gold Payroll and choose Help - About Capital Gold Payroll ….  

Under Licence Details the text ‘Latest Tax & NI Rates Correct at April 2018 (Not 
Using)’ should be displayed. 

 

If the ‘Latest Tax & NI Rates Correct at April 2018 (Not Using)’ caption is not shown, 
the upgrade was not successful. Check that you have upgraded the program in the 
correct folder and try again. If this is still not successful, contact your support 
provider for advice. 

THE CAPTION ‘NOT USING’ WILL DISAPPEAR IN THE NEW TAX YEAR. 
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STEP 2: Completing the Tax Year-End 
 

Here is a reminder of the tasks to carry out at the end of the 2017-18 tax year, for each of the 
Capital Gold Payroll companies. The following procedure applies only when the current period is the 
last period in the tax year.  

Before Completing the Year-End 

1. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 
Back-up Company Data command. 

 

It is advisable to back up your data to a new 
folder so that it does not overwrite an 
existing backup. In the Backup to box, first 
remove the text that is displayed. Then 
enter the drive letter and a new folder name 
for the current pay period, for example 
‘C:\March2018_B’. 

 

 

Completing the Year-End 

PLEASE COMPLETE THESE STEPS IN ADDITION TO COMPLETING MONTH-END 
REPORTS AND OTHER USUAL PAY PERIOD TASKS FOR EACH COMPANY ON YOUR 
PAYROLL. 

YOU MUST CREATE AND SUBMIT THE FPS FILE FOR THE FINAL 2017-18 PAY PERIOD AS 
NORMAL, BEFORE COMPLETING THE TAX YEAR END. OUR RECOMMENDATION IS TO 
CREATE THE FINAL EPS FILE IMMEDIATELY AFTER THE FINAL FPS IS SUBMITTED TO 
HMRC. 

2. Install the Employers Annual Summary report. Select the Reports - Library 
Selection - Summaries command and double-click the Employers Annual 
Summary report. Then close the screen. 

 

3. Select the Reports - Year to-date Summary command: 

i. Print the Employers Annual Summary report. 

ii. Print the Year to Date Summaries report for the entire payroll. This prints a 
substitute for the official P35 CS form and a year-end summary for the company 
that you can use for a file-copy. 

 

4. Select the Reports - Library Selection - Miscellaneous command to select the 
required P60 (End of Year Certificate) from the library. 

Double-click to select either: 

 ‘P60 HMRC Laser Single Sheet’ OR 

 ‘Pegasus Pre-Printed Laser P60 (Sealed)’. 

 

5. Select the Reports - Year-end Forms command to print a P60 for each employee. 
Make sure your printer is loaded with the P60 stationery for the 2017-18 tax year. 

 THIS CAN BE DONE AFTER THE YEAR-END IF NECESSARY. 

 A P60 WILL NOT BE PRINTED FOR EMPLOYEES WHO LEFT 
DURING THE TAX YEAR. 

 

6. After all FPS submissions have been sent to HMRC for the 2017-18 tax year you 
MUST send an EPS for the end of the tax year, even if Recoverable Amounts or CIS 
deductions don't apply. 

Open the Online Services – Send Employer Payment Summary form to create 
the final EPS file for the tax year and select the Final Employer Payment 
Summary for Tax Year checkbox. 
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STEP 3: Starting the New Tax Year 
THIS CHECKLIST DETAILS THE SUGGESTED STEPS FOR THIS PROCESS. PLEASE 
AMEND AS NECESSARY TO MATCH YOUR NORMAL PAYROLL TASKS. 

Before using Capital Gold Payroll (4.05) in the 2018-19 tax year, the information for the old tax year 
for each company on the payroll needs to be cleared. Here is a list of tasks to start the new tax year 
in Capital Gold Payroll. 

Running the Year-end and Checking Details & Options 

1. Backup the Capital Gold Payroll data files using the File - Back-up & Restore - 
Back-up Company Data command. 

 

It is advisable to back up your data to a new 
folder so that it does not overwrite an existing 
backup. In the Backup to box, first remove 
the text that is displayed. Then enter the drive 
letter and a new folder name for the current 
pay period, for example ‘C:\March2018_C’. 

 

 

2. Select the Company - Year-end Restart command. To confirm you want to 
continue, click either Yes or No as necessary. 

On the Apprenticeship Levy Settings screen select either the ‘Select maximum 
allowance’ checkbox or the ‘No allowance’ checkbox at the bottom of the screen. If 
the allowance is to be shared across companies, enter the amount for this company. 

A DATA BACKUP IS COPIED AUTOMATICALLY TO A FOLDER CALLED ‘LASTYEAR' 
IN THE MAIN CAPITAL GOLD PAYROLL FOLDER, WHICH BY DEFAULT IS 

‘C:\PEGASUS\GOLD PAYROLL\ LASTYEAR’. 

 

3. On the Year-end Restart form, click to select the to-date totals to clear down in the 
column to the right of the Pay Rate and Payment & Deduction descriptions (only 
to-date totals are cleared). Many are already selected by default. Click again to 
reverse the selection if necessary. Then click OK. 

 

4. If Capital Gold Payroll Plus Pack is activated, clear the year’s history records if 
required. On the next Year-end Restart form select the drop-down lists to delete the 
year’s records for pay history, diary entries, and costing records. Then click OK. 

 

5. Click OK to confirm the new tax year. Any employees with an ‘L’, ‘M’ or ‘N’ prefix tax 
code are automatically updated with the new codes for the 2018-19 tax year.  

6. After the Year-end Restart has finished, create employee records for new 
employees starting at the beginning of the new tax year using Add New Employee.  

You may need to check Auto Enrolment contributions or amend employee details 
using Alter Current Employee, for example, changing an employee’s tax or NI 
code, student loan plans, normal hours worked per week, company director status or 
Scottish taxpayer status. 

 

7. Update your Company Options screen for the NICs Employment Allowance, Small 
Employer Relief and Apprenticeship Levy.  

8. If you are going to payroll company cars details in the new tax year, and have 
already registered with HMRC to do so, add company car details and allocate them 
to the employees using the Configure Company Car Details screen if necessary. 

If you have cars that will meet the Real Driving Emission Step 2 (RDE2) regulation in 
the 2018-19 tax year, we advise that you set the Fuel Type for vehicles to ‘Diesel 
Meets RDE2 Regulation’ and Recalculate the cash equivalent after year-end 
processing and before you run the first payroll of the new tax year. 
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9. To help with running payroll in the new tax year, update the Payroll Calendar 
screen with Payroll Dates and BACS Creation Dates and Processing Dates. Also, 
check that the work period dates are correct. 

 

10.  For those employees who have attachment of earnings orders, review the 
outstanding balances by opening the Employee details screen and clicking the 
AEO Settings screen on the Pay/Deds tab. 

 

11. If you are still using the ‘default’ password(s) for your payroll software, that is, those 
provided on first installation, we strongly recommend you change them to help you 
comply with General Data Protection Regulation (GDPR), which is effective from 25th 
May 2018. 

 

TIPS:  
1. YOU CAN CHECK THE AVAILABILITY OF THE GOVERNMENT GATEWAY USING THE 
ONLINE SERVICES – GATEWAY AVAILABILITY MENU ITEM. SELECT THE PAY AS YOU 
EARN (PAYE) LINK. 
2. USE THE CAPITAL GOLD PAYROLL F1 HELP FOR ASSISTANCE.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

End of Guide 

https://online.hmrc.gov.uk/login?GAREASONCODE=-1&GARESOURCEID=PayeAorEAll&GAURI=https://online.hmrc.gov.uk/paye/&Reason=-1&APPID=PayeAorEAll&URI=https://online.hmrc.gov.uk/paye/
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